Meridian 1
Option 11C Compact
MAT 6

Introduction Guide

Document Number: P0890124
Document Release: Standard 3.0
Date: January 1999

This nortel documentation is protected by copyright. It may not be copied in any form or medium e:
puruant to the Nortel License to Copy Documentation ("License"). If a License has been purchasec
be enclosed with this copy of Nortel documents.

© 1999
All rights reserved

Printed in Canada
Information is subject to change without notice. Northern Telecom reserves the right to make changes in design
or components as progress in engineering and manufacturing may warrant. This equipment has been tested

and found to comply with the limits for a Class A digital device pursuant to Part 15 of the FCC rules.

Meridian 1 is a trademark of Northern Telecom.

Meridian 1 Option 11C Compact MAT 6 Introduction Guide



Document Revision history

Date Document Version Product Release
January 1999 Standard 3.0
November 1998 Standard 2.0
October 1998 Preliminary 1.01
January 1998 Standard 1.0

Meridian 1 Option 11C Compact MAT 6 Introduction Guide



P0890124 Standard 3.0 January 1999



Contents %

Contents

About ThisGuide ............ ... ... ... ..... 1

Who thisguideisfor ........ ... . 2

Whatyou need toknow . ....... ... .. .

Conventions used inthisguide . . ........... ... ... ...

Where to go for more information ... ........... . ... ... . ... 3

Howtogethelp ....... .. . 4

About The Product . ......... ... ... ... ...... 5

Your PBXSyStem . . ... ... 5

MAT 6 for Option 11C Compact . .. ... 6

Installing MAT For Compact . ................. 9

What this task requires .. ... ... . 9

Installation guidelines . ....... ... . ... . . 9
Connecting Your PC to the Option 11C Compact Switch ... .... 10
Installing MAT for Compact . . ............ ... 11

Configuring MAT For Compact ............... 13

What thistaskrequires ... ......... . i 13

Configuration guidelines . ........ ... . .. i 14

Changing your configuration . ........... ... ... . . . .. 15

Starting And Using MAT For Compact ......... 17

Startthe program . ... . 17

Change the default login . ........ .. ... ... . i 18

YOur orientation ... ... . 19
What Navigator does . .......... .. 19
Opening a site and launchinga system ...................... 21
Using a System window . .............. ... 21
Opening and launching your applications .. .................. 22
Scrolling and selectingentries . ............ ... . 22

Meridian 1 Option 11C Compact MAT 6 Introduction Guide



vi  Contents

Performing Administration Tasks .. ........... 23
COMMON tEIMS . . . .o e

Synchronize the program with your switch . . ...................
Procedure ... ... ...
Moretolearn .. ... .

Designate alinecard .............. i,
Procedure . ... ... ...
Moretolearn . ....... ..

Defineatemplate ......... ..
Procedure .......... . .. .
Default templates . ......... ..
Moretolearn ... ...

Add a telephone (usingatemplate) .......... ... . ... .. ... ...,
Procedure . ... ... ...
Moretolearn . ....... ..

Move atelephone . ... . . .
Procedure . ... ... ...
Moretolearn . ....... ..

Add avoice mailbox . ....... ..
Procedure . ... ... .. ...
Moretolearn .. ...... ..

Change the prime Directory Number . . ................ ... .....
Procedure . ... ... ...
Moretolearn . ....... ..

Change the Call Party Name Display . ............. ... .. .....
Procedure . ... ... .. ...
Moretolearn .. ...... ..

Generate basicreports . ... . e
Procedure . ... ... ...
Moreto learn . ...t e

P0890124 Standard 3.0 January 1999



Contents  vii

Where ToGoNext ......... ... . ... ........ 53
Add-On Applications . . ...................... 55

Switch Configuration ....................... 57
Availablecards . ... . . 57
Possible slots .. ... . 58
Installed configuration . .......... ... ... . . . 58
System ID and password . ..... ... e 59

Meridian 1 Option 11C Compact MAT 6 Introduction Guide



Viii Contents

P0890124 Standard 3.0 January 1999



List of figures

ix

List of figures

Figure 1

Meridian 1 Option 11C Compact PBX system . ................. 6

Figure 2

Basic components of MAT for Compact . ...................... 7

Figure 3

MAT Login dialog box . ........ ... i 17

Figure 4

MAT Login dialog box (changing the default) .................. 18

Figure 5

Change Password dialog box .. ...... ... ... . i 18

Figure 6

Navigator Window . .. ... ... 19

Figure 7

Navigator functions .. ......... ... i 20

Figure 8

System WIiNdOW . . . ... 21

Figure 9

Station Administrationwindow . ............ .. . . .. .. 22

Figure 10

CPND Administration window . ............ ... ... 22

Figure 11

Synchronization dialog box ............ ... . . 25

Figure 12

Hardware Configuration dialogbox . . ......... ... ... .. ...... 27

Figure 13

M2008 property sheet (defining atemplate) .................... 29

Figure 14

GBMLCAP template . ....... ... . . . 31

Figure 15

HospMLCAP template . . ... . . 32

Meridian 1 Option 11C Compact MAT 6

Introduction Guide



x  List of figures

Figure 16
2500GuestSettemplate . ... ..

Figure 17

Add Station dialog box

Figure 18
M2008 property sheet (adding a station) .......................

Figure 19
M2008 property sheet (moving a station) ......................

Figure 20
Key Assignments dialog box . ......... ... ... L

Figure 21
Voice Mailbox dialog box ......... ... ... . .

Figure 22
Directory Numbers dialogbox ......... .. ... ... .. ... . ...

Figure 23

CPND property sheet

Figure 24
Select a Form File property sheet ........... . ... ... ... ......

P0890124 Standard 3.0

January 1999

33

36

37

40

42

43

46

48

50



List of tables Xi

List of tables

Table 1

Introduction to MAT for Compact’'s components . . .

Table 2

COMMON tBIMS . . e e e e e e e e e e e

Table 3

Available add-on applications . ................

Table 4

Available peripheral equipmentcards ...........

Table 5

Possible card locations .. ............ .

Table 6

Customer’s installed cards and their locations . . . ..

Table 7

User ID and Password for system (or switch) ... ..

Meridian 1 Option 11C Compact MAT 6

Introduction Guide

55

57

58

58

59



xii  List of tables

P0890124 Standard 3.0 January 1999



Page 1 of 60

About This Guide

Welcome to Nortel's complete communications product for the small
business Meridian 1 Option 11C Compact!

This is an introduction guide to help you get acquainted with MAT 6,
specifically for Option 11C Compact. This guide complements the existing
MAT documentation suite. The other MAT documents in your Option 11C
Compact package are not based on any particular Meridian 1 switch.

MAT stands for Meridian Administration Tools. This is the PC software that
will help you manage your phone (PBX) system. Hereafter, we refer to this
software as simplWAT for Compact

This guide provides the following:

e general information about your new PBX system

e guidelines for installing and configuring MAT for Compact at your
site, if this has not already been done

e an orientation to MAT for Compact and instructions for performing
common administration tasks for your PBX system

e pointers to related Nortel documents where you can find more
information, and to optional MAT applications for adding software
capabilities that you might want

Meridian 1 Option 11C Compact MAT 6 Introduction Guide
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Who this guide is for

We provide this guide for two audiences:

¢ mainly for the customer who will use MAT for Compact to manage
the day-to-day needs of their company’s PBX system

» also for the distributor technician who may need guidance for
installing and configuring MAT for Compact

Note: The customer will need important switch configuration and
system ID/password information that the technician can provide.
Appendix B provides tables for recording this required information.

Often the technician installs all of the MAT software, and may configure the
software and provide training for the customer as well. Sometimes, however,
the customer needs to install and configure the software. In either case, the
installer can find guidelines fdmstalling MAT For Compact” on page,9
followed by guidelines fofConfiguring MAT For Compact” on page 13

What you need to know

MAT for Compact runs on a PC using Windows 95, Windows 98, or
Windows NT Workstation 4.0. Familiarity with Windows operating systems
is helpful for using MAT for Compact.

Some MAT for Compact customers have a limited understandiR@ &f
systemsThese are the phone systems that operate within companies or
buildings. Also, some MAT for Compact customers have no previous
exposure to Nortel's MAT software. Whatever your level of experience may
be, this guide is the best place to begin.

So put on your administrator’s cap. Soon you will be up and running!
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Conventions used in this guide
This guide uses the following typographical conventions:

User input—This font alerts you to information that you enter on
your keyboard; or, using your mouse, this font indicates buttons to
click or menu selections to make.

Multi-lettered keys—Angle brackets denote a single multi-lettered
key on your keyboard. For examphEsc> denotes the Escape key,
labeledEsc on PC keyboards.

Key sequences—Keys that you press at the same time include at
least one multi-lettered key and are not separated by spaces in text.
For examplegAlt>V instructs you to press thalt> andVv keys at

the same time.

Hot keys—You can access menu commands by using the mouse or
your keyboard. Menu items show one letter as underlined. To
choose a menu item from the keyboard, hold dowraAlte key and
press the underlined key. For example, pradsF to open thesile

menu.

Windowsrefers to the Microsoft family of graphical user interface
(GUI)-based operating systems.

Where to go for more information
We provide you with other guides and online information:

See the guides entitlédderidian Administration Tools MAT 6
Installation and Upgrades User GuidadMAT 6 User Guides
Volumes 1 and Z'he guides are part of your complete product
package.

All MAT for Compact commands are completely defined in the
online help. You can access help topics and context-sensitive help
from the Help Menu of the Navigator, System, and application
windows. You can also access context-sensitive help by clicking the
Help button in any of the program’s dialog boxes, or by pressing the
<F1> key after selecting (highlighting) any field.

Meridian 1 Option 11C Compact MAT 6 Introduction Guide
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How to get help

Contact your distributor technician if you have problems that are specifically
related to your phone switch or MAT for Compact installation. Your
distributor may provide MAT for Compact training as well.
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About The Product

Your product package includes the following:

e Meridian 1 Option 11C Compact phone switch

* hardware security dongle (a small connector that plugs into your PC’s
parallel port), with serial number and keycode

« MAT 6 software on CD-ROM

« this guide and the guides entitletéridian Administration Tools
MAT 6 Installation and Upgrades User GuidedMAT 6 User
Guides Volumes 1 and 2.

Your PBX system

The Meridian 1 Option 11C Compact switch is the center of your PBX system.

Peripheral devices such as telephone sets and fax machines connect to this

switch through pre-wired ports (modular phone jacks). Each active phone jack
at your site has a correspondiegminal numbex(full hardware address) on

the phone switch.

MAT for Compact knows these hardware addresses and other switch data. This
is how MAT for Compact selectively manages each device in your PBX
system.

Meridian 1 Option 11C Compact MAT 6 Introduction Guide
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Figure 1

Meridian 1 Option 11C Compact PBX system
Cable

Distribution

PC with MAT ;

for Compact
Terminal
Numbers

Meridian 1
Option 11C Compact

MAT 6 for Option 11C Compact

MAT for Compact runs on a PC using Windows 95, Windows 98, or
Windows NT Workstation 4.0. MAT for Compact includes Nortel's Station
Administration application and Common Services. Station Administration
and its sub-application Call Party Name Display (CPND) are user
applications. Common Services includes basic MAT features and functions
that support these applicatiofsgure 2is a diagram of the MAT for Compact
components and their relationships. Seele 1onpage 8for a brief

description of each component.

As new functions and features become available for Option 11C Compact,
these are reflected in MAT. To access the latest features, select the correct
machine type (11C Compact) and the most recent software release in the
System Data tab in the System Properties page for a particular Option 11C
Compact. MAT uses machine type and software release information to
identify various systems.
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Figure 2
Basic components of MAT for Compact
MAT for Compact
Applications
" Add-On | Station
Applications i
A [.EI_'_I_ y Admin CPND
(optional) |
]
|
! Common | Services
- - - — —
[ | | |
. PC Event Site/System
Navigator - hedul
9 File Scheduler Admin
[ |
System Terminal User
Window Emulation Admin

The Add-On Applicationdox in Figure 2 represents optional MAT

applications for adding capabilities to MAT for Compact. Your distributor
can help you license and activate any applications that you request. For more

information, see Appendix A gmage 55
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About The Product

A brief introduction to the basic components in MAT for Compact follows:

Table 1

Introduction to MAT for Compact’s components

Component

Description

Station
Administration

This primary application simplifies day-to-day adds, moves,
and changes for different types of single and multi-lined
telephones. Station Administration enables you to
configure and program features for each station (telephone
set, modem, fax machine, etc.).

Administration

Call Party This sub-application of Station Administration lets you
Name Display | manage single and multi-line CPND information. CPND
(CPND) displays the source of an incoming call at the called station.
Navigator This main window allows access to all MAT systems and
services. The Navigator window shows the names and
types of currently available systems, for example, MAT for
Compact's sample system and your site’s system.

PC Event File | From the Maintenance menu in the Navigator window you
can open a PC Event File window to quickly view a log of
important PC system events.

Scheduler From any supported application, for example, Station
Administration, you can schedule tasks such as system
updates.

Site and From the Configuration menu in the Navigator window

System you can add, change, and delete sites and systems. A site

is a physical location that includes one or more systems.

Administration

System From the Navigator window you can open one or more

Window System windows. A system is a configuration that you
define for your phone switch. The System window is where
you launch Station Administration, CPND, and any add-on
applications that you purchase separately.

Terminal From the Maintenance menu in the System window you

Emulation can open a System Terminal window to directly connect to
the phone switch. There you can access overlay programs
by virtue of your serial, Ethernet, or PPP connection.

User From the Security menu in the Navigator window you can

open the MAT Users window to create and update
templates that define user access and connections.
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Installing MAT For Compact

Often the distributor technician installs MAT for Compact, in which case the
customer can skip this chapter. Sometimes, however, the distributor
technician installs the phone switch and peripheral hardware, and then asks
the customer to install MAT for Compact. If this is your situation, use the
guidelines in this chapter to ease your task.

MAT for Compact includes the MAT 6 software on CD-ROM.

What this task requires
These are your considerations as system administrator:

e Allow one to two hours to comfortably complete this installation. It
is safer to carefully handle all of the details in one sitting than to
interrupt the process.

¢ You canconfigureMAT for Compact on a separate occasion, using
the guidelines undétConfiguring MAT For Compact” on page 13
Note, however, that you cannot use the software to manage your
PBX system until it is both installed and configured.

¢ Have ready the MAT 6 CD-ROM.

¢ Have ready thderidian Administration Tools MAT 6 Installation
and Upgrades User GuidndMAT 6 User Guides Volumes 1 and 2.
The guides are part of your complete product package.

e Scan theMeridian Administration Tools MAT 6 Installation and
Upgrades User Guid gauge the complexity of its procedures.
These procedures will be easier to follow if you are familiar with
Windows operating systems.

Installation guidelines

The distributor technician usually establishes the required physical connection
between the Meridian 1 Option 11C Compact phone switch and the PC on
which MAT for Compact will be installed. The first guidelines in this section
are for making the physical connection. Then guidelines are provided for
installing MAT for Compact.

Meridian 1 Option 11C Compact MAT 6 Introduction Guide
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Connecting Your PC to the Option 11C Compact Switch

Designate a PC running Windows 95, Windows 98, or Windows NT
Workstation 4.0 as the PC on which you will install MAT for Compact. Before
connecting this PC to the phone switch, make sure the PC can meet hardware
and software requirements. In thieridian Administration Tools MAT 6
Installation and Upgrades User Guidefer to “Step 3: Checking PC

Hardware and Software” in the chapter “Setting Up Your MAT Environment.”

You can connect the designated PC to the Option 11C Compact phone switch
by using either a serial connection or an Ethernet connection.

Serial Connection

The Option 11C Compact switch provides three serial ports (0, 1, and 2) on the
bottom left of the backplane below the CPU pack. You can configure the PBX
software for these serial ports in LD17. Refer to “LD17” in @ygtion 11C
Compact Input/Output Guide.

Ethernet Connection

The Option 11C Compact switch provides a 10 Mbps Ethernet connector on
the bottom left of the backplane below the CPU pack. This 15-pin connector
provides a standard attachment unit interface (AUI) connection point for a
media attachment unit (MAU). You can configure the PBX software for the
Ethernet port in LD117. Refer to “LD117” in ti@ption 11C Compact
Input/Output Guide.
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Installing MAT for Compact
Use the following instructions if either of these situations applies:

You are installing MAT for the first time.
You are changing the Windows operating system.

Note: If you are upgrading from MAT 5 to MAT 6 and planning to

stay on Windows 95, refer to tMeridian Administration Tools MAT

6 Installation and Upgrades User Guide.

Open theMeridian Administration Tools MAT 6 Installation and Upgrades
User GuideThe following chapters are valid for installing MAT for
Compact:

“Setting Up Your MAT Environment”

Do steps 1 through 3: “Preparing a network plan,” “Checking
Meridian 1 requirements,”and “Checking PC hardware and
software.”

Do step 4: “Setting up Windows networking for MAT.”
Follow the appropriate instructions (Windows 95, or Windows 98
or, Windows NT Workstation 4.0).

Do step 5: “Setting up the PC communications environment.”

Most sites use PC serial communications. If your site uses Ethernet
communications, follow the appropriate instructions and also do
step 6: “Testing ethernet and PPP connections.”

Do step 7: “Setting up the server environment,” if you are setting up
MAT 6 on a server.

“Installing MAT 6 Software”

Use the procedure “Installing and upgrading MAT 6 on a
stand-alone PC.”
Do steps 2 through 15, step 17, and steps 20 through 22:

— Plug your security dongle into your PC’s parallel port in step 2.
The connector on the back of the dongle lets you reconnect a
printer or other device that was previously connected directly to
the parallel port.

— Use your MAT 6 CD-ROM in step 6.

Meridian 1 Option 11C Compact MAT 6 Introduction Guide



Page 12 of 60 Installing MAT For Compact

— Use your MAT for Compact serial number and keycode in step 13.
e “Validating the MAT 6 Installation”
Use the entire procedure.

This procedure uses MAT for Compact's sample system to complete
important installation tasks and connect to your phone switch.

e “Adding Applications or Licenses”

Use this procedure to install any optional MAT applications that you
order after the initial installation. See Appendix Agage 55
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Configuring MAT For Compact

If the distributor technician installed MAT for Compact, he or she may have
proceeded to configure your site and system in the program. If this is the
situation, the customer can skip this chapter. Otherwise, use the guidelines in
this chapter to configure MAT For Compact.

Each PBX system is unique. You must configure MAT for Compact before
you can use the software to manage your system. This task includes the
following procedures:
* defining a site
A siteis a physical location that includes one or more systems.
e defining a system

A systenis a configuration for your phone switch.

What this task requires

These are your considerations as system administrator:

e Allow up to one hour for configuring your site and system, though
you may complete this task in much less time.

« Have ready th#eridian Administration Tools MAT 6 User Guides.
The guides are part of your complete product package. In the guides,
you will need to refer to thBIAT 6 Common Services User Guide

¢ You perform these procedures from the Navigator window, which is
the main window in MAT for Compact.

Meridian 1 Option 11C Compact MAT 6 Introduction Guide
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Configuration guidelines

Open theMeridian Administration Tools Common Services User Gtadke
chapter entitled “Configuring Sites, Systems, and Users.” The following parts
of this chapter are valid for configuring MAT for Compact:

— *“Changing the Default Login Password”

Use this procedure to start MAT for Compact if the program is not
already running, and to change the default User ID and Password if you
are running the program for the first time. This procedure opens the
Navigator window.

Note: This procedure is also documentedae 18f this introduction
guide.
— “Site and System Administration”
Use the procedure “Adding a site” to configure your site.
— “Site and System Administration”
Use the procedure “Adding a system” to configure your system.
« Do steps 1 through 6.

For step 6, most sites use PC serial communications. Use the
instructions for Ethernet communications if appropriate.

e Do steps 8 through 10.

For step 10, you need to enter a User ID and Password for the switch
in theGeneral tab of the Customer property sheet. This information
is provided by the distributor technician. Segble 7onpage 59

In theNumbering Plans tab, you need to insert a number range that
includes all of your PBX system’s extensions, catiactory
numbersin MAT for Compact. Typically, the customer develops
their Numbering Plan.
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Return to the Navigator window to complete your system configuration:

1 Double-click your new system icon to open the System Window.

2 Choose Update System Data from the File menu.

3 Select the options Update Data Stored inthe PC  and Do it Now , then
click OK.

MAT for Compact initiates a connection with the switch and retrieves
system data. This means system data is copied from the phone switch
into MAT for Compact on your PC.

4 Right click your new system icon and select Properties .
This opens the System Properties Sheet.

5 Click on the System Data tab and verify that the Machine field
specifies 11C Compact and that the Release field specifies 1.

6 Click OK to return to the Navigator window.

Changing your configuration

You can easily change any information about your site or system. For
example, you may want to change your site’s name or address. Or, you may
want to change your system’s name or customer (user) information.

To change site or system information:

1 Select the desired site or system in the Navigator window.
2 Choose Properties from the File menu.

This opens the property sheet for that site or system.

3 In the property sheet, select the tabs containing information you want
to change.
4 Edit the fields you wish.

Some fields have a popup menu for selecting items, or a drop-down list
of choices (indicated by an arrow in the field). Bolded fields indicate
required information.

5 Click OK to save your changes and return to the Navigator window.

Alternatively, you can click the Apply button to save your changes
while keeping the property sheet open.

Meridian 1 Option 11C Compact MAT 6 Introduction Guide
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Alternatively, you can addnothersite or system by using the instructions
under“Configuration guidelines” on page 1€onsider doing this if you
decide to expand your facility, or if you want to separate areas of your PBX
system to configure those areas differently.

To delete a site or system:

1 Select the site or system in the Navigator window.
CAUTION: Deleting a site also deletes all of its systems.

2 Choose Delete from the Edit menu and click OK.
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Starting And Using MAT For Compact

This chapter shows you how to start MAT for Compact and gives you an
orientation for using the program. To use the program, you will open its
Navigator window, then a System window, and finally the desired
application. This is the sequence given in this chapter.

At this point, MAT for Compact should already be installed and configured
for your PBX system. If so, you are ready to start the program.

Start the program
Start up MAT for Compact. The installation process has added the MAT icon
to your WindowsStart menu.
1 From the Start menu, select Programs , then MAT.
A MAT Login dialog box appears.

Figure 3
MAT Login dialog box

NERTEL

NORTHERN TELECOM

K.

User ID I Cancel

s

Password I Help

2 If you previously set up your User ID and Password, type in this
information and click OK.

After the program accepts your ID and password, the Navigator
window opens.

Note: If you are running this program for the first time, go to “Change
the default login” on page 18.
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Change the default login

Follow these steps if you are running MAT for Compact for the first time, or
if you have not previously changed the default User ID and Password:

1 In the MAT Login dialog box, type in the default User ID and Password
ADMIN and click OK.

Figure 4
MAT Login dialog box (changing the default)

NERTEL

NORTHERN TELECOH OK

User ID IADMIN Cancel |
Password Im Help |

This opens the Navigator window.

2 In the Navigator window, choose Change Password from the
Security menu to open the Change Password dialog box.

Figure 5
Change Password dialog box
Change Password m
Enter a new password. Confirm the 0K

password by entering ita second time.

0Old Password I*‘“‘”““‘

Help
New Password I
Confirm Password I

Cancal

Pl

3 Type the default password in the Old Password field. Type your new
password in the New Password and Confirm Password fields, and then
click OK.

4 Click OK in the message box to confirm your password change.
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Your orientation

The Navigator is MAT for Compact’s main window. All MAT systems and
program features are available in or through this window.

Figure 6
Navigator window

M MAT Navigator !Em

File Edit “iew Maintenance Configuration Security  Utilities  Window  Help

AEEE N EEREREE)

For Help, press F1 /4

What Navigator does
The Navigator gives you these capabilities:

— Allows you to define and redefine sites and systems for your business

— Displays a tree structure of the site(s) and system(s) defined for your
business, plus MAT for Compact’'s sample site and system. You access
a system by opening its site in Navigator, for example, the Sample Site
shown in Figure 6.

— Lets you launch your System window(s) by name, for example, the
Sample System highlighted in Figure 6

— Helps you manage all phone-system functions and data by site, system,
station, and user

— Allows you to launch utility applications, for example the Scheduler

— Allows you to display licensing and release information for MAT for
Compact and any add-on applications that you purchase separately
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Figure 7 illustrates basic Navigator functions. For more details, see your
MAT 6 Common Services User Guide

Figure 7
Navigator functions
, Launch :
Navigator - System Windows ‘
‘ PC Event Log ‘
Launch
4>‘ Scheduler ‘
‘ Scheduler Queues ‘
‘ Sites ‘
‘ Systems ‘
‘ Users ‘
Configure
4g>‘ User Passwords ‘
‘ System Modem Scripts ‘
‘ Notification Options ‘
Print
4>‘ Reports ‘
Displa ‘Application Information ‘
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Opening a site and launching a system

The Navigator allows you to access any defined system. In the Navigator, you
open a site to choose a system on which to work.

« Open a site by double-clicking its icon or name, or by clicking the
“+” symbol next to the site. The “+” changes to a “-” when the site
opens. An open site displays all systems defined for that site. Close
a site by clicking the “-” symbol.

* Double-click a system to launch its System window and launch
applications for working on that system.

For Meridian 1 (M1) systems, the components that make up the system
appear in the System window. For non-M1 systems, or for an application such
as Meridian Mail, MAT for Compact displays a terminal emulation window.

Using a System window

From the Navigator, launch MAT for Compact’s sample system to open its
System window.

Figure 8
System window

EI Sample Site - Sample System - M1 System Window !Em

File Yiew Maintenance Security  Window  Help

=] x| 2| =)= o]
ttn:ns ‘ il
[

-8 Station Administration

ForHelp. press F1 MNotconnected 4

The System window is where you launch applications for working on that
system. These applications include Station Administration, CPND, and any
add-on applications that you purchase separately.
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Opening and launching your applications

Open and launch the Station Administration or CPND application from the
System window by double-clicking its icon or name.

Figure 9
Station Administration window
E Sample Site - Sample System - Station Administration
File Edit Y“iew Swnchronize Forms Options Help
+ |+ |+
Sync Prime Terminal
Location Type Status DN Number
Ofc_7 MZ2008 NEW 4105 00100011
Ofc_10 M2008 NEW 4106 00100010
Ofc_9 M2008 NEW 4107 00100009
Ofc_8 M2008 NEW 4108 001 00008
Ofc_11 M2008 NEW 4109 00100007
<] »
[ station [ Dialog [ [ |
Figure 10

CPND Administration window

E Sample Site - Sample System - CPND Administration

File Edit ¥iew Swynchronize Help
2] =]
Customer Sync Status Number Name
0 RPL 4170 Mel Borel
0 RPL 4171 John Limon
0 NEW 4500 Bruce Smith
0 RPL 5000 Gary Lewis
0 RPL 5001 Arlene Catalana
<« »
|[CPND Mame | [

Scrolling and selecting entries

Use the up and down arrow keys or Page Up and Page Down keys to view all
entries in application windows. Click an entry to select it. Then double-click
the highlighted entry to view its associated data.
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Performing Administration Tasks

This chapter shows you how to use MAT for Compact to perform common
administration tasks for your PBX system.

These are common tasks, most of which you are likely to perform. Do the
synchronization task first. Do the next three tasks in the order given.

e Synchronizing the program with your switch

» Designating a line card

* Defining a template

¢ Adding a telephone (using a template)

e Moving a telephone

¢ Adding a voice mailbox

e Changing the prime directory number

e Changing the Call Party Name Display

« Generating basic reports

To find more information than we provide here, look in the guides entitled
Meridian Administration Tools MAT 6 User GuidésVolume 1, refer to the
Station Administration User Guide.

Common terms

Here are definitions for common terms used in the procedures that follow:

Table 2
Common terms

Term

Definition

Prime Directory
Number (DN)

The primary extension assigned to a telephone or other
device that is connected to your PBX system

Station

A peripheral device such as a telephone, modem, or fax
machine that is connected to your PBX system

Terminal
Number (TN)

A hardware address on the phone switch that corresponds
to a phone jack (or port) where a station is connected
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Synchronize the program with your switch

The purpose of this task is to ensure that MAT for Compact and the phone
switch share the same data. This is a task to perform whenever changes are
made at the switch or in the program.

On your PC, MAT for Compact has a database of stored PBX-system data.
The phone switch has a corresponding database. When you synchronize the
program with your switch, one is given an accurate reflection of the other.

Usually the first synchronization task after installing a new PBX system is to
retrieve all station and CPND data from the phone switch. This downloads
data from the Meridian 1 database (on the switch) into the MAT for Compact
database (on your PC). Thereafter you will most often transmit (upload)
selected data from your PC to the switch. This will keep the switch’s data
current with settings that you change in the program.
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Procedure

Note: This procedure retrieves initial station and CPND data from the
switch, assuming your distributor technician has already configured that data.
If your technician has synchronized the switch and program already, you can
still use this procedure to learn how synchronization works.

Begin in the Station Administration window of your system.

1 Select Retrieve All from the Synchronize menu.
2 In the Station Retrieve All dialog box, click OK.

This opens the Synchronization dialog box.

Figure 11
Synchronization dialog box

Synchronization Ed |

Help

Priority Hold Till
[EOTNE] | Dee lime
[10/27/98 | [ 1:33pm | LCancel |

Station Retrieve All

Warning: Remember to clear the communication log file
periodically.

3 In the Synchronization dialog box, click OK to retrieve station data
immediately (at present date and time).

4 Verify the retrieved station data in the Station Administration window.

Data retrieved from the switch will have a Sync Status of TRN (for
transmit) in each station entry. This means that the station data you are
viewing in MAT for Compact is synchronized with the switch’s data.

5 Close Station Administration and launch CPND Administration.

6 Select Retrieve All from the Synchronize menu.
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7 In the Call Party Name Display Name Retrieve dialog box, click OK.
This opens the Synchronization dialog box.

8 In the Synchronization dialog box, click OK to retrieve CPND data
immediately (at present date and time).

9 Verify the retrieved CPND data in the CPND Administration window.
Retrieved CPND data will also have a Sync Status of TRN.

More to learn

To update the switch’s data with changes in MAT for Compact, use the
Synchronize - Transmit function in your Station Administration and CPND
windows. You can use theshift> key with your mouse to select (highlight)
multiple entries to transmit.

Each time that you add, change, or delete station or CPND data, the program
prompts you to schedule data transmission to the switch, but only if the
program is in Maintenance mode. We recommend that you set Maintenance
mode. You can do this by selectimMgde from theOptions menu in the

Station Administration window.

The Sync Status field in the Station Administration and CPND windows is
important. Sync Status in MAT for Compact can be any of the following:

e NEW for newly defined station or name data in MAT for Compact
that has not been uploaded to the switch

e CHG for station or name data that has been changed in MAT for
Compact, but has not been uploaded to the switch

e RPL for station or name data in MAT for Compact that you have
defined to replace previously synchronized data on the switch

e OUT for station or name data deleted in MAT for Compact that has
not yet been deleted on the switch

e TRN for synchronizedtation or name data, data that has been
transmitted (uploaded) to the switch

Once you transmit data to the switch, station and CPND entries that are
retained (not deleted) receivd BN status in MAT for Compact. Entries for
deleted stations (with a Sync StatusDefT) are removed from MAT for
Compact.
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Designate a line card

The purpose of this task is to define the switch’s hardware configuration for
any station that you hereafter add to your PBX system. In MAT for Compact,
hardware configuratiomrefers to a line card and its exact location in your
switch. MAT for Compact allows three possible cards to be added to your
system. These cards include the digital line card (NTMWO05AA), analog line
card (NTMWOBAA), and analog trunk line card (NTMWO7AA).

This task must be performed before you add a station for the first time.
Usually the distributor technician will have performed this task already.
However, we recommend that you follow this brief procedure to ensure the
proper configuration.

Once you have designated an appropriate line card in MAT for Compact, you

do not need to repeat this procedure unless you run out of voice and data ports

and need your technician to install another card in your phone switch.
Procedure

Begin in the Station Administration window of your system.

1 Select Hardware from the View menu.
2 Select Add from the Edit menu.

This opens the Hardware Configuration dialog box.

Figure 12
Hardware Configuration dialog box
Hardware Configuration m
Card Type
-gK
|NTMWI]5AA 24 Port Digital Line Card j|
Cancel |
Loop Shelf Card
Help
o] P T
Usage
|24 Port Digital Line Card

Note: Inthe Hardware Configuration dialog box, you will need to enter
the type and location of an appropriate peripheral equipment (line) card
installed in your switch. SeeTable 6 on page 58 for this information.
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3 In the Hardware Configuration dialog box, enter the appropriate
information and click OK:

« For Card Type, select the appropriate card in your switch, for
example, the NTMWO5AA 24 Port Digital Line Card

« For Loop, enter the slot number where that card is installed, for
example, 1.

e For Shelf and Card, enter 0. No other number is appropriate.

Now you can add one or more stations to your PBX system. To make that task
easier, first use the proceduigefine a template” on page 29

More to learn

In MAT for Compact, the terminal number for a station is the full hardware
address for the phone jack (or port) to which the station is connected. The
hardware addresses are derived from your switch’s configuration, that is,
each line card’s location and number of ports. Terminal numbers have the
following format:

lll's cc nn

wherelll is the Meridian 1 loop (line-card slot) numbeis the shelf number,
ccis the shelf card position, ame is the line card’s port number. For
example, if your digital-line card is installed in slot 1 and a given station uses
port 14, its terminal number would be:

001 000 14

In MAT for Compact, the significant digits are the line card’s slot number (at
left) and port number (at right). Shelf number and shelf card position (the
middle numbers) are always zero.

If you have questions about the line cards in your phone switch and the
capabilities these cards provide for your PBX system, please consult your
distributor.
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Define a template

Procedure

Figure 13

The purpose of this task is to make it easy for you to add new stations to your
PBX system. You can store data that is common to stations of a specific type
in a MAT for Compact template. A template can contain most settings that

you define for stations, such as key features and station features. Templates

shorten the task of adding multiple stations.

Begin in the Station Administration window of your system.

1
2
3

Select Template from the View menu.

Select Add from the Edit menu to open the Add Template dialog box.

Select your most common instrument (type of device), for example,

M2008 2008 Digital .

Click OK to open the property sheet for the instrument you selected.

M2008 property sheet (defining a template)

First Name

Last Name

Progranm

Key 2

HIIIII
111
HAEEE P
IR REEN

Key 0

EERERL

Customer
0 LI Cancel |

Location

|M2I]l]B_TempI | Features |

Department Admin..

]

Terminal Number

]

Hunt to

]

External Hunt to

1

Call Forward NA to

L ]

External Call Forward NA to

]

Validate

Help

4
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5 In the Location field, you must enter a unique identifier (up to 12
characters) for your template. For example, enter M2008_Templ.

You can disregard the Customer Number field. It is always O.

6 In the rest of this property sheet, define all desired features that you
consider generic for the telephones you will add:

Note: Do not define fields that are unique to each station: the station
user’'s name and the location, terminal number, and extension
(directory number) of a station.

— Click on a numbered key to open the Key Assignments dialog box
and select a single feature for that key. For example, select the
6-Party Conference feature for Key 1, and click OK.

— Click Features to open the Features dialog box and set
characteristics of the telephone. Click (highlight) a feature of
interest, and then click Select to open that feature’s property
sheet. Change settings as you wish and click OK. When you are
finished, click Done to return to the device property sheet.

Note: To get more information about particular features and settings,
use the program’s context-sensitive help. Click the Help button in a
dialog box, or press the <F1> key after selecting (highlighting) any field.

7 Click OK to close the device property sheet.

This saves your template in the program and returns you to the Station
Administration window.

Now you can use this template to add one or more telephones to your PBX
system. Se€Add a telephone (using a template)” on pagddbnstructions.

Default templates
MAT for Compact comes with pre-defined default templates which may be
modified as needed. The templates include:
¢ GBMLCAP - General Business Multi-Line Central Attendant
Position template

« HospMLCAP - Hospitality Multi-Line Central Attendant Position
template

e 2500GuestSet - 2500 Guest Set template
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GBMLCAP - General Business Multi-Line Central Attendant Position
template - is an M2616 Multi-Line Attendant Set template customized to
support general business. The GBMLCAP default template displaying the
supported features is shown in Figure 14.

Figure 14
GBMLCAP template

M2616 E

First Hame Last Hame Customer

I . Location
: - GBMLCAP

I ] I Department

Forward H—I Erogram | Teiminal Number

Call Pickup| [ | Message | | —
Auto Dial [[ || Aute Dial || [000
Auto Dial [[ || AutoDial || Estemal Hunt to
T |
Display |[ | |
|
|

.

Cancel

Features

Admin..

It
1L

Yalidate

H

Help

I

Call Forward MA to

H

Ennlerencel
Transfer |

External Call Forward MA to

[

Add On Modules [0 |
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HospMLCAP - Hospitality Multi-Line Central Attendant Position template -
is an M2616 Multi-Line Attendant Set template customized to support the
hospitality industry. The HospMLCAP default template displaying the
supported features is shown in Figure 15.

Figure 15
HospMLCAP template

M2E16 <]

Firzt Hame Last Name Customer
I I | | Cancel
I ] Location
HospMLCAP Features

Admin_.

I Department

Forward H_| Erogram | Teminal Humber

Call Pickupl Message | Hunt to
Wake Up | Auto Dial | | [000
Cont €05 |[ | AutoDial || Extemal Hunt to

Aoom Key | ’—| |
Dizplay | ’_| |
|
|

H
1L

Yalidate

H

Help

I

Call Forward HA to

H

Eunlerencel
Transfer |

External Call Forward NA to

[

Add On Modules [0 |
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2500GuestSet - 2500 Guest Set template - is an Analog 2500 Guest Set (single
line Analog 2500 Set with Message Waiting) template. The 2500GuestSet
default template supports Controlled Class of Service, Pretranslation lists,
Message Waiting Allowed, Lamp Allowed, Forward Allowed and Hunt
Allowed. The 2500GuestSet template is shown in Figure 16.

Figure 16
2500GuestSet template
2500
First Name Last Name Customer
I | Cancel
— Single Line Features Location
2500GuestSet
EFD ®FwdMoAnsDN D Featuresz
Department

EHT RXHuntDN

DSP  Battery Rev [ ] Admin.

ISP Hook Flash - Terminal Humber Validate
4| | 3
Set | Clear | Duectory Humber Help

L

Forward No-Answer DN

| Hunt to
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More to learn

To modify a template, seletémplate from theview menu, select (highlight)

the desired template entry, then selggtiate from theEdit menu. Treat the
template as if it were the property sheet for a single station. When you finish
your changes and cligBK, this saves the modified template. This template
will affect only new stations that you add using the template. To update
stations already defined with an old template,‘8éwe to learn” on page 38

You may want to define additional templates if you have more than one type
of telephone in wide use at your facility. This will help reduce your
administrative effort over time. Not only will templates speed the task of
adding new stations, but the process of defining templates helps you to more
quickly fine-tune the feature sets that work best for your PBX system.

P0890124 Standard 3.0 January 1999



Performing Administration Tasks Page 35 of 60

Add a telephone (using a template)

The purpose of this task is to add a telephone (station) to your PBX system.
To add a new station in MAT for Compact, whether using a template or not,

you enter station data in a property sheet for the appropriate type of device.
This data defines the configuration and feature set of the device, in this case,

a telephone. The program stores this data in its database on the PC. Then you
schedule transmission of this data to the phone switch to complete the task.

Procedure

Note: This procedure’s prerequisite‘i®efine a template” on page 29

Begin in the Station Administration window of your system.
1 Select Station from the View menu.
2 Select Add from the Edit menu.

This opens the Add Station dialog box.
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Figure 17
Add Station dialog box
Add Station E3
Humber of Stations to Add Customer Humber
Template Ingtrument
2500Guestset 2500 Digitone Standard -
GBMLCAP 00 Analog Standard —
HospMLCAP M2006 2006 Digital
M2008 2008 Digital
M2009 2009 Digital =
M20165 2016 Digital
M2018 2018 Digital
M20185 20185 Digital
M2112 2112 Digital
M2216-1 2216 Digital =
[N Automatic Directory Number Assignment
[ Automatic Terminal Number Assignment
[¥ Create Portable from Location | |
Uk LCancel | Help |
3 In the Add Station dialog box, select your template in the Template

field, enter 1 in the Number of Stations to Add field, and click OK.

This opens an instance of the device property sheet that reads in all of
the information that you defined in your template.
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Figure 18

M2008 property sheet (adding a station)

First Name

Last Name

|Jane

| |D|:|e

E
|
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0 ﬂ Cancel

Location

Features

Admin_.
Accounting

Validate
Terminal Number

001 000 15 Help

]
QLT

I
=
=1
g

External Hunt to

H

Call Forward NA to

H

External Call Forward NA to

In the device property sheet, enter the particular station user’'s name
and department, plus the location, terminal number, and extension
(directory number) of the station. Also assign any unique station

features that this user requires.

— The Location field requires a unique identifier. Use a descriptive

name for your convenience.

— Refer to your site’s cable records for the appropriate terminal
number, and then double-click the Terminal Number field to select
that number from the list of available TNs.

— Click Key 0 and select a key feature such as SCR Single Call
Ringing to display a Directory Number field. Double-click this field
to select and assign an available extension (DN) from the list.

Click OK to close the device property sheet.

When prompted by the program, schedule data transmission to the

switch.
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This completes the basic task, unless you need to connect actual phone
hardware at the specified location.

More to learn

To add a statiowithoutusing a template, first you open the Add Station
dialog box (usingsteps Jand2 of the above procedure). Then, instead of
selecting a template from the Template field (as you diddp 3, select a
device from the Instrument field. This opens the default (undefined) property
sheet for that device.

You can conveniently add more than one station at a time to the program. First
open the Add Station dialog box. Then, instead of entaringhe Number of
Stations to Add field (as you did gtep 3of the above procedure), enter a
greater number. In this same dialog, you specify either a template or an
instrument; a template makes this task much easier. When yowsdljake
Multiple Add Stations dialog box is displayed. This dialog provides a single
list view for defining some of the unique aspects of each station, for example,
the user’s name, station location, and so on.

To modify station data, select its entry in the Station Administration window
and choos&pdate from theEdit menu. This opens the device property sheet
for that particular station, where you can change previously defined data.

To update multiple stations at one time, you can use the Global Update
function. For example, you may want to modify station data that you defined
with an old template, or data that was initially defined for your stations. The
Global Update function lets you change common data values for any number
of entries that you select in the Station Administration or CPND
Administration window. Refer to th&tation Administration User Guider
guidance.

You can delete a station by selecting its entry in the Station Administration
window and choosinBelete from theEdit menu. Similarly, you can delete
that station’s CPND data by selecting the corresponding entry in the CPND
Administration window and choosirizelete from itsEdit menu.
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Move a telephone

The purpose of this task is to allow a user to keep the same extension (or
directory number) while relocating to a different work area.

You do this by assigning a different terminal number for the user, one that
corresponds to his or her new location. This keeps the remainder of the user’s
station data with the user.

Procedure

Begin in the Station Administration window of your system.

1 If the new terminal number has been previously assigned, first delete
its associated station data. See “More to learn” on page 41.

2 Double-click the user’s current station entry.

This opens the property sheet for that entry, for example, M2008.
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Figure 19

M2008 property sheet (moving a station)

First Name

Last Name

|Jane

| |D|:|e

Program

Key 2

EEEEy
EEEE

EEEE 0
JUUOE

Key 0

]

|

Customer

Cancel

,_
R 12l5 2
° |73
g |'-|&
g |78

=2
3 L«
2

Features |

Admin.. |
Accounting

Yalidate |
Terminal Number
001 000 14 Help |
Hunt to

H

External Hunt to

H

Call Forward NA to

|

External Call Forward NA to

Enter the new terminal number and location.

For example, Jane Doe moves from Office 10 to Office 11. The
terminal number for Office 11 is 001 0 00 14, as shown in Figure 19.

Note: You can type the terminal number if you know it, or simply
double-click the Terminal Number field to display the list of available

TNs.

Click OK to close the device property sheet.

When prompted by the program, schedule data transmission to the

switch.
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More to learn

If a terminal number you want to use has been previously assigned, the safest
approach is to first delete its associated station data. To do this, select
(highlight) that station entry in the Station Administration window and select
Delete from theEdit menu. When you confirm the deletion, the station data

is removed from MAT for Compact’s database. The station entry’s Sync
Status changes OUT.

When you transmit notification of this deleted station to the phone switch, the
OUT entry is removed from the program, and the switch deletes its version of
that station data. Be sure to transmit @éT status to the switch before
reassigning the terminal number.
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Add a voice mailbox

The purpose of this task is to set up voice mail for those who need it. The
retrieval of initial station data from the switch will have already downloaded

any voice mailbox assignments made by the distributor technician.

A voice mailbox (VMB) is associated with the prime directory number (DN)

assigned to a station.

Procedure

Begin in the Station Administration window of your system.

1 Double-click the station entry that you wish to modify.

This opens the property sheet for that entry, for example, M2008.

2 In the property sheet, click Key 0 (showing the prime DN).

This opens the Key Assignments dialog box.

Figure 20
Key Assignments dialog box
Key Assignments m
Key Features
OvR Busy Station Override -
PRK Call Park Cancel |
PRS Privacy Release
PY¥N Private Line Non-ringing Help |
PYR Private Line Ringing —
RDL Stored No. Re-dial
RGA Ring Again
RNP Ringing Number Pick-up
SCC Speed Call Controller
SCN Single Call Non-Ringing Clear |
Single Call Ringing -

Directory Number

4488 -

CLID Entry (Mumeric or D)

3 Select a key feature that opens the Directory Number field, for
example, SCR Single Call Ringing.
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4 Double-click the Directory Number field, here showing 4488, to open
the Directory Numbers dialog box.

5 In the Directory Numbers dialog box, keep the current directory
number (highlighted) and click VMB.

This opens the Voice Mailbox dialog box for that prime DN.

Figure 21
Voice Mailbox dialog box

Voice Mailbox - DN: 4488 B

Sync Status  NEW

Customer Number
Cancel

Class of Service

Delete
Second DN

Help

411

Third DN

=< I'=
0.
[«

Keep Messages es

6 Select Yes or No in the Keep Messages field. In the Class of Service
field, enter the number that is defined in Meridian Mail.
7 Click OK.

This creates a voice mailbox for the prime DN and closes the Voice
Mailbox dialog box.

8 Click OK in each dialog box and property sheet that remains open.

When prompted by the program, schedule data transmission to the
switch.

More to learn

To delete a voice mailbox, enter the Voice Mailbox dialog box for the
associated DN and clidBelete. Alternatively, to easily delete a statiand

the mailboxes associated with its directory numbers, select the station entry
in the Station Administration window and cho@ssete from theEdit menu.

The confirmation prompt has a Delete VMB checkbox that defaultg $o
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Voice mailbox data is transmitted and retrieved with station data. Data
synchronization works differently depending on the task at hand. Refer to the
Station Administration User Guider examples of VMB data

synchronization when you add a mailbox, change a DN, or delete a station.
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Change the prime Directory Number

The purpose of this task is to assign a new prime DN to any station that needs
it. You might decide to change your Numbering Plan, for example.

In MAT for Compact, theprimeDN is associated with Key 0 of the telephone.
On the phone hardware, Key 0 is often labeled with this same number.

Procedure
Begin in the Station Administration window of your system.

1 Double-click the station entry that you wish to modify.

This opens the property sheet for that entry, for example, M2008.

2 In the property sheet, click Key 0 (showing the prime DN).
This opens the Key Assignments dialog box.

3 Double-click the Directory Number field to open the Directory Numbers
dialog box.
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Figure 22
Directory Numbers dialog box

Directory Numbers m

Directory Numbers

DN MARP Key Location
4488 Y 0 Office 11
4489
4490
4491

4492 MARP
4403

4494 CPND |
VYMB. .

4495
4496
4497
4498
4499
4500
4501
4502
4503

Current Assignment 4488

0K | Cancel | Help |

4 Select a new (unassigned) DN and click Assign .
This moves the MARP, Key, and Location data to the new DN.
5 Click OK to return to the Key Assignments dialog box.
Here you see the new DN in the Directory Number field.
6 Click OK in each dialog box and property sheet that remains open.

When prompted by the program, schedule data transmission to the
switch.

More to learn

The DNs that are listed in the Directory Numbers dialog box are the numbers
from your Numbering Plan. Your best assurance of easily assigning an
available DN is by viewing this list. Alternatively, you can type a DN in the
Directory Number field of the Key Assignments dialog box.
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Typically, the program does not accept a DN that falls outside the range of
your current Numbering Plan. However, in the Station Administration
window, you can seledtiode from theOptions menu and disable

Numbering Plan validation.

The DNs assigned to a station include the prime DN and that of an associated
voice mailbox. Other DNs areferred toby a station, for example, a DN for

Call Forward. In the Directory Numbers dialog box, you can s&lestD,

MARP, or VMB to link other DNs to a station’s assigned name.
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Change the Call Party Name Display

The purpose of this task is to keep incoming call information accurate for
those who receive calls.

Call Party Name Display (CPND) displays the nhame of an incoming caller to

the user at the called station. CPND data is associated with a DN, and not with
a particular station. When someone changes their name, or when you assign
a previously used DN to a new person, also change the CPND data to match.

Procedure
Begin in the CPND Administration window of your system.

1 Double-click the CPND entry that you wish to modify.
This opens CPND'’s property sheet for that entry.

Figure 23
CPND property sheet

Call Party Name Display Name m

Customer 0K |
o -
Cancel |
Entry Type
& Directory Humber Help |
" Dial Intercom Group
T DNIS IDC

Directory Number

Name
First Name Last Name
|Jane | |Fleming

or get name from Location

Display Format Expected Name Length

| First, Last L||
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2 Change the name and click OK.

This returns you to the CPND Administration window where you see
the changed name in the highlighted CPND entry.

3 Transmit the new data to your switch.
4 Close CPND Administration and launch Station Administration.
5 In the Station Administration window, double-click the station entry that

has the same name you changed in CPND.
This opens the property sheet for that entry, for example, M2008.
6 Change the station user's name and click OK.

Both CPND and Station Administration now know Jane Doe, for
example, as Jane Fleming.

More to learn

CPND data and Station configuration data are treated as separate files within
MAT for Compact’s database. The switch treats this data separately as well.
A user’'s name in Station Administration does not need to match the name
entered in CPND. Only the CPND name and its associated DN get stored in
the switch’s database. However, when using Station Administration for
reporting purposes, you may want to view accurate station name data.

You can directly access and maintain CPND data from the Directory
Numbers dialog boxHigure 23. TheCPND button is particularly helpful for
linking several DNs to a station’s assigned name.
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Generate basic reports
The purpose of this task is to help you view and easily record specific data.

Procedure
Begin in the Station Administration window of your system.

1 Select Reports - Report Generator from the File menu.
This opens the Report Generation window.
2 Select Run Report... from the Reports menu.

This opens the Select a Form File property sheet.

Figure 24
Select a Form File property sheet
Select a Form File m
Automatic Call Distribution Stations -

Class of Service

CPND Name by Directory Number
CPND Name by Location

CPND Mame by Name

CPND Name by Synchronization Status
Dial Intercom Groups

0K Cancel Help
3 Select a Form file of the information that you want to include in a report
and click OK.
4 Specify an output device for viewing the report—your screen, the

default printer, or an Export file—and click OK.

This generates your report.
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More to learn

You can just as easily generate reports from the CPND Administration
window by selectin@Reports from theFile menu.

The Reports Generator includes a form editor for editing existing forms or
creating custom forms.

The standard Form files include the following report types in addition to those
you can view inFigure 24

e Equipment Inventory

e Hunt Patterns

e Key Assignments

e List of Power Failure Phones

¢ Message Centers

e Private Line

¢ Ringing Number Pickup Group

e Speed Call Groups

e System Speed Call Groups

e Telephone Directory (Phone Book)

e Telephone Directory by Department

e Telephone Directory by Directory Number
e Telephone Directory by Location

e Telephone Directory by Name

¢ Telephone Directory by Terminal Number
e Used DN List
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Where To Go Next

For more details about the features of MAT for Compact, see the guides
entitledMeridian Administration Tools MAT 6 User Guid&sefer to the
Meridian Administration Tools Station Administration User Guiael
Meridian Administration Tools Common Services User Guithe. features
described in these guides are in MAT for Compact.

Look at the other user guides in the MAT 6 User Guides volumes for software
capabilities that you might want. Each guide describes a software application
you can add to your system. For ordering information and brief descriptions
of each application, refer to “Appendix A: Add-On Applications’gamge 55

MAT for Compact gives you powerful tools for managing the day-to-day
needs of your PBX system. L